UNITED STATES DEPARTMENT OF AGRICULTURE )
Farm Service Agency Notice LP-2225
Washington, DC 20250

For: State and County Offices

State Office Reporting System (SORS) Enhanced with Ad Hoc Queries

Approved by: Acting Deputy Administrator, Farm Programs

Buodlhy founn

1 Overview

A Background

SORS provides current and historical reports of MAL and LDP activities and historical
reports (up to June 2016) on FSFL activities.

Purpose

This notice provides general information on a new SORS reporting functionality that was
released on November 1, 2016.

The new functionality is expected to be of particular interest to State and County “power
users,” as it offers advanced query capabilities for creating personalized reports.

General public users, including CMA’s, LSA’s, and DMA'’s, will not have access to this new
reporting functionality. Only authorized FSA users will have access to this new reporting
functionality.

In particular, this notice alerts State and County Offices of the new reporting functionality
“Ad Hoc Queries,” which allows authorized FSA users to run personalized queries, based on
the parameters of interest.

Disposal Date Distribution

June 1, 2017 State Offices; State Offices relay to County

Offices

12-5-16

Page 1



1 Overview (Continued)

C Contact

Notice LP-2225

If there are any questions about this notice, State Offices shall contact the applicable
individual according to the following table.

IF the question is about...

THEN State Offices shall contact...

peanut MAL and LDP policy

Kathy Sayers by either of the following:

e e-mail to kathy.sayers@wdc.usda.gov
e telephone at 979-680-5155.

cotton MAL and LDP policy

Kelly Hereth-Dawson by either of the following:

e e-mail to kelly.hereth@wdc.usda.gov
e telephone at 202-720-0448.

sugar commaodity loan policy

Toni Williams by either of the following:

e e-mail to toni.williams@wdc.usda.gov
o telephone at 202-720-2270.

policy for all other MAL and
LDP eligible commodities

DeAnn Allen by either of the following:

e e-mail to deann.allen@wdc.usda.gov
o telephone at 202-720-9889.

CMA, DMA, and LSA policy

Frankie Coln by either of the following:

e e-mail to frankie.coln@wdc.usda.gov
o telephone at 202-720-9011.

all MAL and LDP Automation

Laura Schlote by either of the following:

e e-mail to laura.schlote@wdc.usda.gov
e telephone at 202-720-7785.

In addition, State Offices may develop standard operating procedures for using these reports
for specific tasks, such as MAL maturity date letters.

D Training

PSD will offer a demonstration of this new SORS functionality on a future CLPS call.
Further details will be forthcoming.
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2 SORS Reporting

Notice LP-2225

A SORS Access and the Addition of Ad Hoc Queries
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There are two methods to access SORS reports:

Authorized State and County Office employees are able to access all reports, navigating to

the FSA Intranet Application page
http://fsaintranet.sc.egov.usda.gov/fsa/applications.asp and, within the side
Applications Directory for G-O, click on MAL SORS - State Office Reporting Systems.
Employees can also go directly to the SORS Intranet page
https://intranet-apps.fsa.usda.gov/sors/

The general public is able to access select SORS reports from the FSA’s Price Support

website, Price Support Reports at
http://www.fsa.usda.gov/programs-and-services/price-support/price-support-

reports/index

FSA has added to SORS a new reporting functionality, “Ad Hoc Queries.” The linked text

for “Ad Hoc Queries” is located on the SORS application home page and left sidebar, both
under the “National Reports” and “State Reports” headings.

Welcome FSA USER
SORS Home
Codes & Units

National Reports

LDP Summary
Loan Summary

L il
Ad Hoc Queries

Farm Storage Facility
Loans

elLDP

m FSA Home /[ Applications / SORS Repart Catalog

SORS Report Catalog

National Reports
} LDP Summary
P} Loan Summary
} LDP & Loan Detail
» Ad Hoc Queries
} Farm Storage Facility Loans
b eLDP

Over recent years, FSA has produced reporting functionalities for the distinct reporting needs
of the national and field offices. These reports are helpful for discrete queries when looking
for information on MAL’s or LDP’s in a given commodity year.

The new reporting functionality “Ad Hoc Queries” enables FSA users to run personalized
queries for accessing a wide range of ad hoc data on MAL’s. Because of the extensive data
available in “Ad Hoc Queries,” the csv file, viewed in Excel, will most likely be more helpful
than the web report, viewed in the web browser (i.e. IE Explorer, Google Chrome, etc.). The
web report is intended only for small queries, or for preview of large queries before exporting
to CSV, and so has very strict row limits.

Note: “Ad Hoc Queries” only provide reporting functionalities on MAL’s and not on

LDP’s.
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2 SORS Reporting (Continued)

B Types of Ad Hoc Queries

In selecting “Ad Hoc Queries” either under National Reports or State Reports, the user can
select one of two types of “Ad Hoc Queries”:
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Loan Explorer

The loan explorer provides flexible, multi-level listing of loan details. This report can be
tailored for many different filtering and display options. Most of the information
available on the Loan and LDP Detail (PK8) report is available in this report, but with the
ability to view multiple loans within a single report. In addition, details can either be
displayed in full, or rolled up to a number of different summary levels.

Notes: This report is optimized for CSV output. Extra columns can be removed from the
CSV worksheet as needed.

ACRE was applicable only for crop years 2009 through 2013.

Web output is limited to 100 rows; PDF 100 rows; CSV 5,000 rows.
Loan Explorer with Producer
Flexible, multi-level listing of loan details along with contact producer info. This report
can be tailored for many different filtering and display options. Most of the information
available on the Loan and LDP Detail (PK8) report is available in this report, but with the
ability to view multiple loans within a single report. In addition, details can either be

displayed in full, or rolled up to a number of different summary levels.

Notes: This report is optimized for CSV output. Extra columns can be removed from the
CSV worksheet as needed.

ACRE was applicable only for crop years 2009 through 2013.

Web output is limited to 100 rows; PDF 100 rows; CSV 500 rows.
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2 SORS Reporting (Continued)

C Parameters for Building Ad Hoc Queries

For running “Ad Hoc Queries,” FSA users are able to refine data according to their needs
with the following parameters:

Parameter Acceptable Options
Crop Year any year from 2006 to 2016; “ALL” or Multiple* is an option
Commodity any commodity eligible for an MAL; “ALL” or Multiple* is an option
State any state; “ALL” is an option
County any county; “ALL” or Multiple* is an option
Storage Type All, Farm Stored, Warehouse Stored
Loan Status Outstanding, Fully Liquidated, Canceled
Office Type County Office, Cooperative (CMA, DMA, LSA)
Recourse Status | Nonrecourse, Recourse
Activity Date Maturity Date, Approval Date, Application Date, Date Last Changed in
Range System of Record, Date Last Loaded in SORS

* Some parameters allow multiple selection — more than one but less than ALL — accessed
via the Multiple Selection icon (“J) to the right of the parameter.

Search Parameters @

FSA Home / Applications / SORS / National / Loan Explorer

Loan Explorer

Crop Year: |aLL v |4
Commeodity: | ALL v | U3

State: | ALL v

County:

Storage Type: @ All
Farm Stored
Warehouse Stored

Loan Status: [ Outstanding
Fully Liquidated

Canceled
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Office Type:

Recourse Status:

Filter by Activity Date:

From (mm/dd/yyyy):

To (mm/dd/yyyy):

# County Office
#| Cooperative (CMA, DMA, LSA)

+# Nonrecourse

¥ Recourse

MNone
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2 SORS Reporting (Continued)

C Parameters for Building Ad Hoc Queries (Continued)
In addition to selecting from the parameters, users are able to define the level of detail of the
query. If the user selects the level of detail “Group and Total”, the user can then choose
parameters according to which information will be grouped. Check any of the “Group by”
column names to break out separate line items for each different value (e.g., Commodity).
Uncheck to ignore different values and roll them together into a single subtotal. An asterisk
“* in a report column means it was not selected in “Group by” — if a breakout is desired,
CLICK “Search Again”, scroll down to “Group by”, and check the desired column. The
“Group and Total” option provides quick data summaries. If the user selects the level of
detail “Show Full Detail”, the user then will have access to the data set at the loan number
level.
Level of Detail: @ Group and Total, using "Group by"
Show Full Detail
Group by: State

County

Crop Year

Commodity

Commeodity Class

Farm-stored vs. Warehouse-stored

Loan Type

Loan Status

Recourse Status

Warehouse

Gin Code

Application Date (YYYYMM)

Approval Date (YYYYMM)

Maturity Date (YYYYMM)

Web Report PDF Report CSV Report
3 Filtering and Saving Ad Hoc Queries in Microsoft Excel
A CSV Data and Preparation for Analysis
Since the functionality of “Ad Hoc Queries” is of particular use in Excel, users are advised to
select the “CSV Report” option and open the csv file in Microsoft Excel in order to filter the
data relevant to their analysis. All reports produced as “Ad Hoc Queries” may be filtered in
Excel to provide meaningful statistics.
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3 Filtering and Saving Ad Hoc Queries in Microsoft Excel (Continued)
A CSV Data and Preparation for Analysis (Continued)

Once the file is open in Excel, users can prepare the data for quick and easy analysis per the
following steps:

Step Action

1 Delete the first four rows. In SORS reports, the first three rows are blank and the
fourth row contains a description of the report. The first row should now contain
the column headers.
2 Freeze the top row. Go to the “View Tab” in the Microsoft Office Ribbon.
Within the Window Panel, select “Freeze Panes/Freeze Top Row”. This will
enable the user to scroll through the records and still view the header row.
3 Delete or Hide all columns that are not relevant to the user query needs. Unless
refined in the parameters, an “Ad Hoc Query” will produce a report with 39
columns. Most users will require a small fraction of these columns.
4 Select the Filter option. Go to the “Data Tab” in the Microsoft Office Ribbon.
Within the Sort and Filter Panel, select Filter. This will enable the user to
further filter the report while viewing it in Excel. To filter, click on the
dropdown arrow in a column header, then use the checkboxes to select specific
values.

B Saving the Report

Step Action

1 To save the report, select “Save As”, either from the File Tab in the Microsoft
Office Ribbon or by pushing the keyboard button F12,
2 Select the appropriate file location. Since the default location will be the user’s
Downloads file, the user should select a different file location that is appropriate
for the report.
3 For the File name, remember to include a description of the report in the file
name. For example, if a user created a report of all outstanding CY2015 MAL’s
across the country as of November 15, 2016, the file name should include such
data: CY2015.outstanding.MALs.2016.11.15.
4 For the “Save As” type, select Excel Workbook if you have added any
formatting, filters or graphs. Saving the file as a csv will remove these features.
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Example of A SORS Ad Hoc Query for Maturing Loans

A A SORS Ad Hoc Query for Maturing Loans

State and County Offices can use SORS “Ad Hoc Queries” to identify maturing loans. Such a

report can be helpful for the preparation of demand letters for maturing MAL’s.

FSA Home [ Applications / SORS [ National / Loan Explorer with Producer

Loan Explorer with Producer

Search Parameters @
Crop Year:
Commodity:
State:
County:

Storage Type:

Loan Status:

Office Type:

Recourse Status:

Filter by Activity Date:

From {mmy/dd/yyyy):

To (mm/dd/yyyy):

Level of Detail:

Group by:

2015+ | [0
ALL O
ARKAMNSAS T
ALL
w All

Farm Stored

Warehouse Stored

# Outstanding
Fully Liquidated

Canceled

# County Office
Cooperative [CMA, DMA, LSA)

# Nonrecourse

Recourse

Maturity Date

Group and Total, using 'Group by’
s Show Full Detail

State
County
Crop Year
Commodity
Commodity Class
Farm-stored vs. Warehouse-stored
Loan Type
Loan Status
Recourse Status
Warehouse
Gin Code
Application Date (YY¥yYMM)
Approval Date (YYYYMM)

# Maturity Date (YYYYMM)

| Web Report | | PDF Report | |

C5W Report

o
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